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The Pigman Test Generator continues our test generator series that will allow
teachers to create and store tests based on classical literary works and topics
that teachers will use as part of their class curriculum. More importantly,
however, it will allow teachers to create their test questions once, and then give
the teachers the power to instantly generate random, sequential, or a selected
multitude of tests based on the original questions devised. This is extremely
helpful when teachers have a group of classes covering the same subject area
and tests are given to each class — one following the other.

In real time testing | have found that when similar classes take tests sequentially
throughout the day (or on alternate days), some students have a tendency to
consult with students who have previously taken the test. This wouldn’t be so
horrible if they were really trying to learn about the subject from the knowledge
they acquire, but many of them simply want a rote summary of the information —
answers or questions memorized in sequence -- so they can simply fill in the
blanks, regardless of what they should have learned.

| often felt that it would be a boon to our testing environment if teachers could
generate different versions of the same test, without a lot of work. For example,
it would be helpful if we could take a twenty or thirty question test and quickly put
together four or five variations of this test. Each test would be the same content
for each class but with questions arranged in different orders.

| tried this by hand for a while when | was teaching, and it was amazing how
many students | caught with red faces, when they ultimately realized that the test
wasn’t exactly like the one their friends took earlier in the day or yesterday. On a
multiple choice test, for example, some students (in a misguided attempt at
helping their mentally challenged buddies) memorized the sequence of questions
and answers. When the recipients tried using the same sequence of answers
(without even reading the questions) they were stunned at the terrible grades
they received. Hopefully they learned a lesson.

Well, generating a group of tests for the myriad of topics | was covering became
quite a burden, so | decided it would be handy if | had a computer program in
which | could do the following:

e Create collections of these kinds of questions: fill-in, short answer, multiple
choice, open-ended response

e Save these collections of questions as files that | could edit and reuse in
the future.



e Quickly and easily use the files of questions to generate tests with
questions randomly selected from the entire file.

e Quickly and easily use the files of questions to generate tests with
questions randomly selected from selected ranges of questions from the
entire file.

e Quickly and easily use the files of questions to generate tests with
questions | select from the list of question in the entire file.

e Easily create and regenerate multiple variations of multiple choice tests.

e The program should allow teachers to easily make and generate a variety
of multiple choice tests that can offer random options

e In all of the above cases the program should also provide a neatly
formatted list of answers for each of the questions asked.

Notice that the key words from this list are quickly and easily. Teachers have lots
of work to do, and a lot of this work eats up preparation time. A computer
program that would do this prep work would save a lot of time that could be
better spent on other jobs.

The Pigman Test Generator will do the tasks outlined above. In addition, you
can also format your finished tests the way you want them (you can even paste
graphics into the final test you create); save the generated tests in named files,
for use in the future (although graphics will not be retained); copy and paste your
test information into other documents in your favorite word processor; search for
and insert information in your final tests, and print hard copies to your printer.

The Pigman Test Generator even includes test editors, so that you can quickly
and easily make up your test data and save it in a format that The Pigman Test
Generator can import and append to the current database of questions and
answers. We have even included a simple search puzzle word list. This is
handy for creating search puzzles based on vocabulary, characters, key terms,
etc. This is opened at the start of the program (explained below).

Installing The Pigman Test Generator

Installation of The Pigman Test Generator is relatively easy. First of all be
aware that this software only runs on Window PC machines. It will not work
with Mac or other types of operating systems. If you received the installation on
a CD, simply insert the CD in drive on your computer. If you have autostart set
on your computer the CD will start up automatically after a few moments of
initialization.

If the installation does not start automatically, simply open My Computer on your
Windows desktop and double click the CD drive icon to open the CD window.
Then double click the setup.exe file to get the installation started.



In both cases above, read the installation screen to complete installation on your
computer. After installation is complete, store your CD in a safe place for backup
use in the future. You won'’t need it in the drive to run the program.

If you received your installation via download form the internet, save the file to a
new folder you create on your Windows desktop. You will need WinZip installed
on your computer (available as a free download from www.winzip.com) to unpack
The Pigman Test Generator installation. If you already have WinZip installed,
double click the file you downloaded and WinZip will give you instructions to
unpack the installation and documentation files to the same folder. Once this is
completed you will have the same files that would be found on the CD. Simply
double click the setup.exe file and follow the screen directions to install the
program on your Windows machine.

Using The Pigman Test Generator

Once you have installed The Pigman Test Generator on your Windows PC, you
will see a shortcut icon in the Baggetta_Ware Literary Test Generator folder,
on the Windows desktop. Double click this with our mouse button and a splash
screen will appear for a few moments. This will be followed by the program’s
main screen, illustrated here.
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information about the file being used. Just above the text window you will find a
format bar, which will allow you to format text you enter in the text window. This
works similar to most word processors. First you must highlight text in the




window before making changes to the font type, and font size. Most of the time,
you will probably not even have a need for these functions, but they are there if
you choose to use them.
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At the top of the screen you will see a menu bar. Here is where you will go for
many of the program’s important functions. Let’s take some time to review the
features of this bar (below it many of the same functions are graphically
represented on a toolbar).

Mews Chri+h The drop-down File menu has the options to start
Open A Test File. .. New, when you want to import or generate a new
Save Chrl4s test format. Open A Test File... will allow you to
Save fs.., open final tests that you have saved. You will only

be able to edit and print these saved tests. Save

and Save As... will allow you to save final

Exit versions of the tests you create. Print Current
Test will allow you to send the test on display to a

printer you have attached to your computer. Exit is the only legitimate way to

close the program when you are done. Make sure you save any tests you have

created before exiting the program.

Print Current Tesk  Ckrl+P

The drop-down Edit menu allows you to Select
All (contents of the text window). Cut or Copy
Selected Text. Paste Text (in the text window).
Clear Selected Text (from the text window).
Word Wrap text in the text window (This is a
. toggle switch to turn this feature off or on. Itis on
v Word Wrap OnjOff by default -- checked.). Find Selected Text in
the text window. This feature can be very helpful
in a long test when you want to locate a small
piece of information. These features are grayed out if there is no text in the text
window to be manipulated, as you can see by the illustration here.

Select All Chel+A

The Actions drop-down allows you to Make Puzzles
Make Puzzle from the default word list (customizable). Clear (all)
Clear Text Windows text windows. Open the Multiple Choice Test
Generator. Open the Multiple Choice Test Editor.
Open Question Editor (for generating new data files of
Open MC Test Editor questions and answers). Import Your Question List

Open MC Test Generator

QOpen Question Editor
Import Your Question List




(data files for use in generating new tests).

v Toolbar Onfioff
v Status Bar  OnfOFF

view.

Insert Date/Time

The View drop-down menu offers two features.
These are toggle switches again (checkmark

indicates they are on. With these you can turn
the Toolbar and Status Bar on and off screen

The Insert drop-down menu allows you to Insert
Date/Time into a selected area of the text window.

Test you generate will have a generic heading on

them.

Faormat Font

Bold Selected Text Cirl+B
Italicize Selected Text  Cirl+l
Underline Selected Text Cirl+U

The Font drop-down menu will allow you to
design the font you want to use in the text
window. You will have to select the text first
before making a selection from this menu.
The functions on the toolbar perform these

same actions. Format Font, Bold Selected

Text, Italicize Selected Text, and Underline Selected Text.

v Preview Font QnjfOFF

actually look if selected.

About

The Options drop-down offers one option. This is
a toggle switch too, that allows the user to
Preview Font (in the font window) as it will

The About drop-down will give the user information
about Baggetta_Ware.

The graphic Toolbar does many of the functions, with a few added features,

shown here.
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The center of the main screen contains the control and test information panel. At
the start of the program this panel shows the current database totals.

The control and test information panel is where you will find information about the
current file of questions available. There are three types of tests: Random Tests,

Sequential Tests (plain or randomized), and Selected Questions Tests.

Generate Random Test

Generate Sequential Test

Panel shown here is from another test aenerator

Howr Many Random CQuestions? (101 Maximum)
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Start With
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End With #
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Randomize
Sequential Tests

If the
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View Categories

Generate Test
of Selected

Select Topic Here For Quick Sequential Test

Questions

5

database is divided into categories you will see a “Select Topic..

.” dropdown list.

From this list you can select categories of questions to generate Sequential or
Randomized Sequential tests. Let’s experiment with a sample test included with

the installation.

clicking the View Categories button.

Generating Tests

You can view the available categories in the database by

Okay. Now we are ready to generate a test. Let’'s generate three different test
formats. The first test we will create will be a short quiz of five questions only
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(Randomized Test)

(1)

Pignati?

(2)
pigs?

[Chapter 5] How does Mr.

(3)
as she constantly reminds her?

[Chapter 6] Where do John and Lorraine go to cash the check from Hr.

Pignati account for his wife’s collection of

[Chapter 18] Why does Lorraine understand her mother®s wariness about men,

(4) [Chapter 5] Whom did HMr. Pignati remind John of because of the twinkle in
his eyes?

W
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(the label indicates
the Maximum number
of questions you can
have in a Random
Test). We’'ll use the
Generate Random
Test button, but first
we have to enter a
number in the text
window to the right of
the maximum label.
Type the number 5 in
the window and then
click the Generate
Random Test button.
Instantly you will
have a five question
quiz randomly
selected from the
collected database.
The screen will look




like the illustration here.

The interesting feature here is that if you don’t like this combination of questions,
you can just click the Generate Random Test button again to get a different
combination of questions. Also, if you like this combination, but want to type in
additional information or add a graphic to this test you can type in your
information or paste a graphic into the text box. You can also add line spaces to
make more room, if you like. And of course you can use the formatting features
to change other characteristics of the final test. DO NOT add anything, however,
if you plan on using the Generate Random Test button to create another version
of the quiz. Only make changes to the final version you will save or print.

If you scroll down the textbox page, you will find the answers to the questions
you have created for the quiz. These are numbered accordingly. If you plan on
printing from the program, you might want to tap down a few lines (using the
computer Enter key) to make sure that your answers appear on a separate page
for your use as a test key. You wouldn’t want to print these for your students to
use.

Now let’s create, a sequential test, generated with the Generate Sequential
Test button. Let’s say you only want a five question quiz from this file using only
questions 3, 4, 5, 6, and 7 from the file, in that order. To do this first type the
starting question number in the Start With... textbox. The number must be above
0 and below the maximum allowed. We will type a 3 in the box. In the End
With... textbox we’ll type the number of the last question we want and that is the
number 7 question.

After you have done this, click the Generate Sequential Test button to get your

results in the text window. You should get a quiz made up of the five questions
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Sequential Test button you will get randomized quizzes of the five questions you

opted for. Pretty neat, right?

Sometimes you might just want to pick the questions from the saved file and use
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Check the questions you would like to use in the test.
01 [Chapter 1] What do John and Lorraine sign at the start of the story? [
02 [Chapter 1] Who is the man John and Lorraine are going to record inf
03 [Chapter 1] What school do John and Lorraine go to?
04 [Chapter 1] In which grade are John and Lorraine in high school?
05 [Chapter 1] John explains that he and Lorraine are recording the infor
06 [Chapter 1] Where are John and Lorraine recording the information al
07 [Chapter 1] Who is Miss Reillen?
08 [Chapter 1] What nickname has been given to Miss Reillen and why?
09 [Chapter 1] We learn from John that he has a reputation as a [what]. +
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Generate A Selected Test |

Cancel Test

to the left of the numbers.

them to make up a quiz
or test. Again, using the
same file, let’s create a
quiz of question we
want. We’ll use
questions 2, 5, 6, 7, and
10. To do this we will
use the Selected
Questions button.

When you click the
Selected Questions
button, you will get
another window that will
open on screen. For
The Pigman Test
Generator it will look
like the illustration here.
All of the questions in
your file are listed here
numerically and each
has a check box placed
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Check the questions you would like to use in the test.

You can select the
questions you want to use
in your selected questions
quiz by clicking the

respective check boxes.
You will be able to scroll
down the window if there
are more questions you
can’'t see. When you have
completed your selection,

01 [Chapter 1] What do John and Lorraine sign at the start of the story? 4
02 [Chapter 1] Who is the man John and Lorraine are going to record inf
03 [Chapter 1] What school do John and Lorraine go to?

04 [Chapter 1] In which grade are John and Lorraine in high school?

10 [Chapter 1] By what nickname is John known because of his pranks?
11 [Chapter 1] John claims that his reputation as a bad boy comes from
12 [Chapter 1] About what is the rule has Lorraine set down for John?

click the Add Selected
Questions button to place
your selections in the
bottom window. You can
remove question you don't
want by reversing the
process, using the bottom
window and then clicking

13 [Chapter 1] In their oath, John and Lorraine to do [what] as they tell th
14 [Chapter 1] What do John and Lorraine call their work work about Mr. g%

| Add Selected Questions | Remove Questions from Selection |

These questions will be used -- select questions you want to remove

05 [Chapter 1] John explains that he and Lorraine are recording the information
06 [Chapter 1] Where are John and Lorraine recording the information about Mr.
07 [Chapter 1] Who is Miss Reillen?

08 [Chapter 1] What nickname has been given to Miss Reillen and why?

09 [Chapter 1] We learn from John that he has a reputation as a [what].

Generate A Selected Test

Cancel Test




the Remove Questions from Selection button.

If you are happy with the questions you have selected, you can then generate
your quiz by clicking the Generate A Selected Test button, located at the bottom
of the screen. If you change your mind about this test altogether, just click the
Cancel Test button to return to the main screen.

After you generate a test (or while you are working on one), be sure to save your
work using the Save (or Save as...) option on the Menu Bar. If you do this you
will assure yourself that you will have these tests to use or edit in the future.

A word about printing. The Pigman Test Generator is designed mainly for
creating tests and answer keys that teachers can use for in their classes. You
can print from the program, but we suggest that you use the printout for your use
in making copies of the tests you create. You will want to make sure that the
answer key is not included with the test you copy for your students, and it is
generally more economical to use a photocopier to make duplicates for your
class rather than printing an entire class worth of tests from your printer.

Don’t forget, too, that you can copy the contents of the text window in this
program and paste the contents into a more elaborate word processor for printing
or formatting.

Generating Search Puzzles
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The Pigman Test
Generator will allow
you to create search
puzzles for your
students to work with.
These could be based
on vocabulary,
terminology,
characters, foreign
words, etc. You
decide. The program
uses a default list of
vocabulary words
located in a file in the
program directory.
This file is called
DefaultWordList.wds.
This is simply a text
file, but it must have
the .wds extender at
the end, and the file



must be placed in the program directory. The list contains words from which the
default search puzzle will be constructed. (No more than 35 words are allowed.)

You can create your own DefaultWordList.wds file and save it to the directory
(overwriting the old one), using your own list of words or other data. Simply use
Microsoft Notepad, which comes with Windows, to create the list. Type one entry
per line and then tap the Enter key to move down a line. The program will only
accept 35 entries (you can have less) from which to make puzzles. Save your
file when you are done. If the .wds file is removed from the directory you will get
an error at the start of the program. To fix this simply create a .wds file and save
it to the program directory.

To generate a search puzzle click the Make Puzzle option on the Actions drop-
down menu. This will open the puzzle window.

The puzzle screen will be blank when you first enter it. Click the Show Puzzle
button and you will get the answer pattern created by the program for the default
list of words. If you don’t like the structure of the puzzle answers, click the
Revise Puzzle button to get a different version, until you are satisfied.

You can take a look at the default list by clicking the Show Word List button at
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the bottom of
the screen.
You will get a
scrollable list
to view. You
can close the
list window
by clicking
the Show
Word List
button again.
This also
acts as a
toggle switch
— off and on.

When you
are happy
with the
arrangement
of the
answer
scheme, you
can click the
Generate



Puzzle button to construct the final puzzle. Here we show the finished puzzle
and the word list on display.

The final puzzle can be printed from the program or it can be copied and pasted
into a word processor for final printing.

To get to the print preview screen, click the Print Puzzle button.

You can't see the

Complete _page In the The Pigman Test Generator Word Puzzle ~
preview window
rv to find the hidden words in this puzzle. ey
T find the hidd ds in thi 1 Th
UnleSS yOU ScrO” might be forward, backward, up or down. Good luck.
dqwn'ThepUZZ|e|S NSYTLASYEENDOQEFPEMSY
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T 1. AVARICE 2. BOW 3. BULWARE 4. CLEF 5.
pastg it into your COLLUSION 6. COUNTENANCED 7. COVEY 6. CREVICES 9.
favorite word DIGNITY  10. DISTILLATE  11. DIVERT _ 12. ESCARPMENT
processor USG the Cloze Guick Print

Close button when
you are finished.

Making Question and Answer Files To Import Into
The Pigman Test Generator

You can enhance the power of The Pigman Test Generator by creating additional
question files that you can append to the built in database. They are easy to
create and will give you a larger base to generate from.

Questions you originate can be just about any type. Here are some typical
formats:

e Simple fill-in questions. This can be a statement with a blank line that
requires the students to answer with a word or phrase to complete it. It
doesn’t necessarily have to be in the form of a question.



e Multiple choice. The question or statement is presented, followed by three
or four possible choices as answers.

e Short Answer. The question or statement is presented and students must
provide an appropriate short answer.

e Vocabulary. A definition is given that requires a studied word, or vice
versa.

e Problems. A problem is offered and the solution must be given by the
students.

e Open Ended Question. An idea is offered and students must respond with
their solutions. Your acceptable answers might just be suggestions.

When planning the question and answer files you will be using, keep in mind the
following set up format.

You will need a question.
You will need an answer for the question.

There are two ways to make the original files used by The Pigman Test
Generator. You can make them manually by using any standard text editor or
word processor that can save files in text format. You can also make them by
using our handy Question Editor that is built into the program menu, under
Actions.

Using A Text Editor or Word Processor

If you create your question and answer file using a text editor (Microsoft Notepad,
for example), open a New document and set Word Wrap on. Type your
information using the following format exactly:

On the first line type the title of your question answer file

On the second line type the number of questions you will have in the file
On the next line type the first question

On the next line type the first answer

On the next line type the second question

On the next line type the second answer

Continue this pattern until you have typed all of your questions and answers.
When you are finished, Save the file as a text file (this is especially important if
you are using a word processor which usually saves as a document file). Some
text editors automatically attach a .txt extender at the end of the file. If this is the
case, after you save your file, locate it using My Computer or Explore and use
the Rename option of Windows to change the extender from .txt to .tga. If you
don’t have this extender on the end of the file name it will not be recognized by
the program



If you want to see how the actual files are constructed open the Sample Generic
Questions.tga file that accompanies the program installation in your text editor

and take a look at it.

Using the Question Editor in The Pigman Test Generator

Version 3.2.0
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ou can use this editor to create

Question Editor

We have made
question and
answer file
creation a bit
easier with the
inclusion of the

guestions that can be imported into -
your test generator program. Use the | Confrols QueStlon
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blank editor will
open on screen

and look like the
illustration here.

This add-in program makes file construction easy because you will only be typing
one question and answer at a time. If you want to open our sample file or any
other file you create, use the Open File button. To start a new file, click the New
File button. First you might wan to click on the File Name textbox to type in the
title of your question answer file. Make the name simple and recognizable. After

VYersion 3.2.0

. The Pigman Test Generator

"—h‘e Pigman Test Generator

Question Editor

ou can use this editor to create
questions that can ke imported into

your test generator program. Use the Contrals

controls here to create, save, and open | Abark ok

your new file. — it
Save File | |

[uestion

|r|'he author of 'Cliver Twist' was who? Herman Melville, Mathanial Haw
Anzwer

Charles Dickens

File Marne

|5ample Generic Duestions |

i | *

Question #7

This Is A Sample File Not Necessarily For This Program

you put in the name
you can start creating
the questions and
answers for your file.
Type a question in the
Question textbox and
then tab down to the
Answer textbox to type
the correct or
suggested answer for
this question. Click the
scroll bar at the bottom
of the screen to go to
the next question.



Continue typing questions and answers until you are done, and then click the
Save File button to save your question and answer file. We suggest that you
make a new folder with subfolders somewhere on your computer that will house
all of your question and answer files.

If you decide not to use the file you can use Abort Work to stop work on a file
and simply Quit to return to The Pigman Test Generator.

APPENDIX I: Multiple Choice Test Generator

The Pigman Test Generator offers the option to create multiple choice tests.
These tests are built differently from the regular questions imported into the
generator so we have a separate add-on program to do the work and also a
special multiple choice editor to help you prepare your lists of questions with
ease.

Before using the Multiple Choice Test Maker you will want to create a list of
questions and answers. Once you have this list of material you can use the
Multiple Choice Test Maker to create many variations on the list. So let’s take
a look at the Editor first, to see how it works.

To get to the editor, start The Pigman Test Generator and click the Actions
menu at the top of the screen. On the drop down list, click Open MC Test Editor.
It is the fourth option on the dropdown list. You should see the editor appear on
screen and it looks like the image here.

The Pigman Test Generator Multiple Choice Test Editor ThIS lOOkS Slmllar
to the regular test

A , editor, but it is
‘Qhe P lgmall TeSt Generator refined to accept
Us;:’r;liﬁjizdi;a;ilzecg;l:‘iour CDntmlsMU'tip"@ Choice Test Editor multlple choice
e | questions and
possible choices. The first Qut possible answers.

choice thould be the comect |
answer.

Question

| At the top of the

First Answer [This should be the CORBECT answer) Third Answer Choice screen 1S the

| | control panel

Second Answer Choice Fourth Answer Choice WhICh WI” a”OW

| | you to start a NEW

i ) FILE, OPEN FILE,
SAVE FILE,

Enter TITLE of this project --»>»»» | ABORT F“_E’ and

QUIT.

You can see that

there are boxes to type your question and four possible answers — the first

answer will always be the correct answer. This is important; otherwise you




will not get correct results in the answer keys.

At the bottom left there is a scroll bar which you will use to move back and forth
through the questions as you create them, and at the bottom right is a box where
you should enter the title for your test. Keep this reasonably short. Here’s what
the editor looks like when you have completed work on a question or series of

questions and answers.

The Pigman Test Generator

Multiple Choice Test Editor

A’ “%h‘e P Igman Test Generator
Ll Sl e EontmlSMuItipIe Choice Test Editor

worksheets. You will need to |

type in a question and four Abart Work |

poszsible choices. The First Guit
choice should be the correct Save File | |
ANsWer. =

Question

|At the start of the story what is Mr. Jones's physical condition

First Answer [This should be the CORRECT answer] Third Answer Choice

He's drunk He's injured by a kick from a bul

Second Answer Choice Fourth Answer Choice

He's worried He's sick

[T [

Word #1

Enter TITLE of this project --3333> |Anima| Farm

When you have
complete all of
the questions
and answers you
want in this file,
be sure to SAVE
your file with a
unique name that
you will
recognize and in
a location on
your hard drive
or network you
will have access
to. The file will
be automatically
appended with
an .mct extender.

Make sure you have typed only the number of questions and answers you want

to use in the test variations.
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Files

Use QUIT to close the
Multiple Choice Test Editor
when you are through
creating lists of questions
and answers.

Sequential Q. and Ans. Random Q. and Ans.

{+ Word Answers
" Letter Answers

{+ Word Answers
" Letter Answers

Sequential Questions
and Answers

When you have a multiple

Answers

;e Pigman Test Generator

Random Questions and

Sequential Q./Random Ans. Format Options

(¥ Word Answers + Answers Presented
" Letter Answers Horizontally

Answers Presented
Vertically

Sequential Questions
Random Answers

choice ﬁle Created that you Open a test database file. .

want to use, you can
create multiple variations
on this database using the
Multiple Choice Test
Generator. Here’s how
you access it. On the
Academic Test Generator
menu, click the Action item
again and from the
dropdown menu this time




select Open MC Test Generator. This is the third item on the dropdown menu.
The test generator opens and looks like the image here.

Before you can use the Multiple Choice Test Generator (MC), you must open the
file you just created, or some other that you have
stored away. You can easily do this by clicking the
Files menu at the top of the screen and from the
dropdown list select Open Multiple Choice

Close With Save Database. Do not try to open other than an .mct file.

They will not work. If you have a correct file the

menu will close and a red message will appear on screen indicating that your file
is now ready to use.

Open Multiple Choice Database

Close With MO Save

At the top of the screen you will notice a control panel with some large buttons
and some option dots.

Sequential Q. and Ans. Random Q. and Ans. Sequential Q. /Random Ans. Format Options
* Word Answers {* Word Anzwers f* Word Anzwers - Answers Presented
i Letter Answers {— Letter Answers { Letter Answers Horizontally
Sequential Questions Random Questions and Sequential Questions Anszwers Prezented
and Answers Answers Random Answers Wertically

The control panel has three separate additional panels and each will determine
how your variation of the questions and answers will be set up. In each separate
panel you have the choice of having your answer key displayed as Word
Answers or Letter Answers. Each question will automatically be labeled as A., B.
C., and D., followed by respective answer choices. If you click the Word Answer
dot (the default for each of the panels at the start), your answer keys will be
displayed as a list of words or phrases, each numbered according to the question
it pertains to. If you choose Letter Answer, then the answer key will only show
the correct letter that should have been chosen to answer the question.

To quickly generate a test or worksheet from any of the panels, click the
corresponding large button for that panel. Here’s what you will get for results
using each button:

Sequential and Answers will give you a test that uses the exact order you
entered the questions and answers in the file you created. But every time you
click the button the order of the questions will vary. It would be most effective to
produce an answer sheet using Word Answers rather than Letter Answers for
this option.

Random Questions and Answers will give you a test that changes the order of
each question in the list and a different order for the answers.



Sequential Questions and Random Answers will give you a test that keeps the
original order of the questions, but changes the order of the answers for each

question.

Format Options will allow you to generate answer options horizontally or

vertically.
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Files

Sequential Q. and Ans. Random Q. and Ans.

¥ Viord Answers
(" Lefter Answers

% VWord Answers
" Lefter Answers

Sequential Questions
and Answers

&the Pigman Test Generator

Sequential Q./Random Ans. Format Options

{*" Word Answers
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(" Lefter Answers
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Random Answers
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Your Tests Are Ready To Generate

The Pigman Multiple Choice Test

Name Date

1. What was the Pigman's wife's name?

Constance
Conchetta
Candace
Cordelia

2. Lorraine thinks she is
A) Unpopular
B) Pretty

C) No pretty

(
(
(
(D) Popular

.

Multiple Choice Test met

E:\BW Source Fileshd, C TestGeneratorshMy Multiple Choice Test Maker 3.1 T5Multiple Chaoice T estshThe Pigman

Clear Text

Close With Save (this is
the third item on the
dropdown menu.

If you select Close With
NO save all of your work
on the generated test will
be discarded.

When you want to save
this test to use, click
Close With Save and your
file will be transferred to
the main test generator
screen, as shown here.

.. The Pigman Test Generator

This might seem a bit
confusing at first, but
once you start using
the Multiple Choice
Test Generator, you
will easily become
accustomed to its
features. A completed
test will look like the
illustration here.

If you are satisfied with
the test as it is, you can
now transfer this to
The Pigman Test
Generator screen for
further modification
(different spacing, add
images, etc.).

You can do this easily
by clicking the Files
menu at the top of the
screen and selecting

File Edit Actions View Insert Font Options About
S B BIU > dES
b -
& The Pigman Test Generator
Generate Random Test | How Many Random Questions? (202 Maximum) View Categories
Start With End With # Randomre e —
Generate Sequential Test R L=sh Sequential Tests of Selected
| Select Topic Here For Quick Sequential Test j Questions
Fixedsyz j |1El j
The Pigman HMultiple Choice Test A
Hame Date
1. What was the Pigman's wife's name?
(A) Constance
{B) Conchetta
{C) Candace
(D) Cordelia
2. Lorraine thinks she is —--—-—----——-
(A} Unpopular
(B} Pretty
{C) Ho pretty
(D) Popular
3. What is Lorraine’s mother's iob? b
Mot Saved Line: 1 Cal: 1 4/8/2008 | 9:20 &M 2.03 KB




From here you can now modify the file any way you want, even adding graphics,
and then print, using the Print option found on the File menu.

If you want to use any of the regular functions of the program you will have to
clear the Multiple Choice test first, using the New option on the File menu.

PROGRAM UPDATES and SUPPORT

As with all Baggetta_Ware products we have tried to keep this software simple to
use and yet functional enough to make it useful. We hope to improve the
program yet and welcome any suggestions you might have. You can forward
them to us through our web page or directly via email at the following address:
baggetta@baggetta.com.

If you encounter any problems with the program, we will try to help you resolve
them as quickly as possible. Please send us email at the above address
detailing the problem. Be sure to include information about your computer
system makeup and any error messages you might encounter. Baggetta_Ware
and affiliates are not responsible for any damage caused by unforeseen bugs or
issues to other software and hardware you may be using. Do not use this
software if you cannot agree to these terms.

Copyright -- Questions and answers for our test generators have been devised
by Baggetta_Ware and are not to be used for resale or redistribution in any form
without the expressed permission of Baggetta Ware.

You can register your purchase on line at our site www.baggetta.com

A. Baggetta
Baggetta_ Ware



